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  Used symbols

Specifica�ons

NOTE:

 Ac�on related to so�ware performance 

Symbol Meaning

CAUTION:

 Supplementary informa�on

 Important informa�on

 Ac�on related to hardware performance

WARNING:  Informa�on with excep�onal importance
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 CAUTION: Do not expose the oscilloscope to impacts or input voltages beyond the limits 
specified in the documenta�on! Use this instrument only for its intended purposes and strictly observe 
the opera�ng instruc�ons!

  Safety
 

 NOTE: Read this manual before using BOSA-02 and BOSA-04 oscilloscopes.

 WARNING: When performing any checks with an engine running in an enclosed space such as 
garage or workshop, always ensure a good ven�la�on! Never inhale the exhaust gases from the 
vehicle! They contain carbon monoxide, a colorless, odorless, extremely toxic gas, whose inhala�on 
can lead to unconsciousness or death!

  High voltage igni�on systems! The igni�on systems in modern vehicle, especially  WARNING:
such as DIS – Wasted Spark and DI – Coil-On-Plug, can generate voltages high enough to stop your hart! 
Be extremely careful when working with this systems!

  CAUTION: Always set the parking brake securely and block the drive wheels before performing 
any checks or repairs on the vehicle.

 CAUTION: When working with the oscilloscope, always use only accessories and tools that 
meet the quality and safety standards requirements!

 CAUTION: When working with the oscilloscope, keep all leads and cables away from moving 
parts and hot surfaces! 

  Use personal protec�ve equipment! CAUTION:
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  Warranty 
 

 Benev Science & Technology warrants that this product will be free from defects in  Ltd. 
materials and workmanship for a period of two (2) years from the date of shipment. If any such product  
proves defec�ve during this warranty period Benev Science & Technology will repair ,  Ltd., at its op�on, 
the defec�ve product without charge for parts and labor, or will replace it.
 It is customer’s responsibility to no�fy us in the event of a defect occurring within the warranty 
period, as well as packing prepara�on and payment of the transporta�on costs to the our office. Benev 
Science & Technology Ltd. bears the transporta�on costs of delivering the repaired or replaced product 
back to the customer.
 This warranty shall not apply to any defect, failure or damage caused by improper use or 
improper or inadequate maintenance and care. Benev Science & Technology shall not be obligated  Ltd. 
to furnish service under this warranty in the following cases:
 – The product has been disassembled, modified, or repaired by persons who have not been 
explicitly authorized for this by  Ltd. and in the event of damage or Benev Science & Technology
replacement of warranty s�ckers.
 – The product has been under impacts beyond the limits specified in its documenta�on or has 
been used in conjunc�on with defec�ve products or such that are not in compliance with the quality 
and safety standards.
 – In the case of natural disaster, such as fire, earthquake, flood, etc.
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BOSA is a modern digital oscilloscope for measurements of analog input signals and is specially 
developed for the purposes of automo�ve diagnos�cs. It is made in two modifica�ons, 2-channel  
(BOSA-02) and 4-channel one (BOSA-04). With its innova�ve and compact design, full galvanic 
isola�on and high reliability, convenient USB interface, built-in special engine tester func�ons for 
analysis of igni�on systems in the internal combus�on engines, as well as with its modern Windows 
based GUI so�ware, BOSA is an indispensable assistant in everyday work of all automo�ve service 
professionals.  BOSA is a versa�le tool and is not related to a par�cular automo�ve brand or vehicle 
model. It is designed with excellent test capabili�es for all types of igni�on systems and sensors used in 
modern cars. The instrument also can be used by a wide range of technicians who need to measure and 
visualize electrical signals.

  1. Overview

Specifica�ons

2-channel or 4-channel modifica�ons

Compact and robust aluminum enclosure

Features

Mul�lingual interface and documenta�on

Full set of engine igni�on diagnos�c modes

Windows based so�ware applica�on StudioBOSA

70 MS/s max sampling rate

Fully galvanically isolated USB interface

 1.1 Basic features

 1.2 Applica�ons

  Internal combus�on engine igni�on diagnos�cs

  Automo�ve diagnos�cs

  General measurements and analysis of electrical signals

Trigger system completely implemented in hardware

Short circuit protec�on between oscilloscope’s inputs

Standard DSO modes of opera�on
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 2.1 Device overview

  2. BOSA-02 и BOSA-04  
 

Status

A B

BOSA-02 Front panel

BOSA-02 Rear panel

1

2

3

1. Analog inputs (BNC)
2. USB connector
3. Status LED
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1. Analog inputs (BNC)
2. USB connector
3. Status LED

A B C D

BOSA-04 Front panel

BOSA-04 Rear panel

1

2
3
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 2.2 Technical specifica�ons

Number of channels

Resolu�on

Bandwidth (-3 dB)

Input ranges

Max real-�me sampling rate (RTS) 

Time ranges (Stream mode)

Time ranges
(Slow Variable mode)

2

12-bit

1 MHz

±0.1 V; ±0.2 V; ±0.5 V; ±1 V; ±2 V; ±5 V; ±10 V; ±20 V

2 MS/s (1 or 2 channels)

Specifica�on BOSA-02 BOSA-04

Time ranges 1 µs ÷ 2 s

Trigger (hardware)

Full galvanic isola�on

Opera�ng temperature range

Input protec�on

Languages 

(2)Auto, Single , Free; Rising / Falling edge

Yes

-20 ÷ 50°C

± 350 Vpp, AC / DC

English, Български

StudioBOSA

Igni�on tester func�ons

Input impedance 1 MΩ || ~20 pF

4

2 MS/s (1 or 2 channels)
1 MS/s (3 or 4 channels)

Max equivalent-�me sampling
(1)rate (ETS)  

72 MS/s (1 or 2 channels) 72 MS/s (1 or 2 channels)
36 MS/s (3 or 4 channels)

Max stream sampling rate
 

100 kS/s (1 channel)
  50 kS/s (2 channels)

100 kS/s (1 channel)
  50 kS/s (2 channels)
  20 kS/s (3 or 4 channels)

1 s ÷ 100 s

0.5 min ÷ 100 min

Input coupling AC / DC (so�ware controled)

Yes

Yes

Dimensions 110 x 70 x 45 mm 110 x 150 x 45 mm

Weight 200 g 425 g

Input type BNC

Pla�orm Windows; USB 2.0, 3.0 or 3.1

(3)Trigger delay  1 µs ÷ 1 min (1 µs step)

(2)Pretrigger  0 ÷ 100 %

Humidity (rela�ve) 10 ÷ 80 % (non–condensing)

1  ( ) ETS is available only in �me ranges from 1 µs to 100 µs.
2    200 µs to 2 s.( ) Available only in �me ranges from

  .(3) Not implemented in StudioBOSA 

Cylinders display patern Parade, Raster, Overlay, Single

Short-circuit protec�on
between inputs

Yes
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 BOSA-02 and BOSA-04 are designed to operate in an industrial environment with increased 
electromagne�c pollu�on. In addi�on, when tes�ng the secondary igni�on circuits in petrol engines, 
it is possible to penetrate high-frequency interference through the USB interface to the computer, 
which can create addi�onal difficul�es in the measurement process. In order to avoid such problems 
and to increase the level of security for the high voltage igni�on tes�ng, the internal architecture of 
BOSA-02 and BOSA-04 has been developed with a full galvanic isola�on (both on data lines and power 
buses) of the USB interface and computer on the one hand and oscilloscope’s analog inputs on the 
other. The principal isola�on scheme is shown below.

 2.3 Galvanic isola�on

5

Specifica�ons

UL 1577 Component Acceptance
No�ce #5

U.S. Canada Germany/Europe Interna�onal

DIN EN60747-5-2
DIN V VDE V 0884-10

IEC 747-5
IEC 60950-1: 2001

 Addi�onally, BOSA-02 and BOSA-04 have a built-in short circuit protec�on between NOTE: 
oscilloscope’s inputs.

 The table below shows the list of standards that the isola�on components meet.

A

A

A

A

MCU

Ch. A

Ch. B

Ch. C

Ch. D

USB
interface

Data

Power Power

Data

USB

Isola�on barrier

BOSA’s galvanic isola�on scheme.
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   In the Device Manager right Step 2.
click on the device and choose Proper�es from 
the drop-down menu. In the Driver tab click 
Update Driver bu�on.

   Connect BOSA-02 or BOSA-04 to Step 1.
the PC. When device is connected for the first 
�me, Windows automa�cally installs some 
driver by default, but this is not the correct one. 
In the Device Manager the device is displayed 
with a yellow warning mark, as is shown on the 
le�.

 2.4 Driver installa�on

 For proper opera�on, the BOSA-02 and BOSA-04 need the USB driver pack to be installed. You 
can download drivers from the tech info sec�on on the product’s page:
h�ps://benev.biz/en/bosa-automo�ve-oscilloscopes.html
 The example below demonstrates driver installa�on procedure on Windows 10. For other 
opera�ng system versions the installa�on follows similar steps but you need to use a proper driver 
pack.
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 A�er successful driver installa�on, 
device is displayed in the Device Manager, 
under the USB controllers node, as an properly 
working USB Serial Converter.

   Click the Browse bu�on and Step 4.
navigate to folder containing driver pack.

   Wait just a moment for the Step 5.
driver to be installed successfully.

 Step 3. In the next window choose 
Browse my computer for driver so�ware. 
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  3. StudioBOSA

 StudioBOSA is a specially designed so�ware applica�on for convenient and efficient work with 
BOSA-02 and BOSA-04 oscilloscopes. With its modern and intui�ve interface automa�cally adjus�ng 
to the user selected mode of opera�on, with the presence of special engine tester func�ons and 
analysis capabili�es, this applica�on is a powerful tool for every professional in the field of modern 
automo�ve diagnos�cs. You can download the applica�on from the tech info sec�on on the product’s 
page: h�ps://benev.biz/en/bosa-automo�ve-oscilloscopes.html

 NOTE: For proper communica�on of StudioBOSA with BOSA oscilloscope, USB drivers should 
be installed. Fore more informa�on on how to install the driver pack, please see previous sec�on.

 NOTE: StudioBOSA recognizes the modifica�on of the BOSA oscilloscope plugged into the 
computer and automa�cally adjusts its opera�ng parameters.

 3.1 System requirements

Specifica�ons

Opera�ng system

CPU

RAM

Dispaly

Hard disc free space

 Windows XP*, Vista, 7, 8, 8.1, 10; 32-bit / 64-bit

 1 GHz or be�er; 32-bit / 64-bit 

1 GB or more

1024 x 768 or higher

50 MB or more

Requirements

 * Windows XP requires .NET Framework 2.0 or higher to be installed.

USB 2.0, 3.0 or 3.1 single port

Adobe Acrobat Reader Version 9.0 or higher
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 3.3 Main screen

 StudioBOSA’s main screen is shown below.

9

Oscillogram screen

Main menu

Tools panel

Status bar

Trigger point

Control panel

StudioBOSA main screen.

  Content and func�onality of StudioBOSA's panels change depending on the user NOTE:
selected mode of opera�on.

  StudioBOSA is an applica�on with easy maintenance and virtually does not need a 
special installa�on at all. Just unpack the StudioBOSA.zip file somewhere on your system, for example, 
in the C:\Program Files\StudioBOSA and put a shortcut to the applica�on’s .exe file on your Desktop or 
Start menu. That's all.

 3.2 Applica�on installa�on

  Do not change the structure and content of the unpacked zip archive.NOTE:
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 3.4 StudioBOSA basic features

 StudioBOSA offers built-in capabili�es aiming the comple�on of specific tasks in the field of  
automo�ve diagnos�cs and allowing for quick and easy adjustment of all measurement parameters. 
The main modes of opera�on are:
 Oscilloscope – includes all universal lab scope func�onality with full trigger control.
 Stream – shows the measured signal as a con�nuous data stream.
  – designed for very slow in �me signals with periods in the range of 1 minute to Slow Variable
hours.

 Sparkscope – this is a specialized oscilloscope mode for quick and easy overview of the 
vehicle’s igni�on system opera�on as a whole. 
  – designed to check the igni�on process in the secondary igni�on system with Distributor
mechanical distributor.
  – designed for the case of igni�on system with single coil on two sparks.DIS (Wasted Spark)

 CAUTION: When working with the oscilloscope, always use only accessories and tools that 
meet the quality and safety standards requirements!

 Mul�meter – this mode allows to use the oscilloscope as a mul�channel digital mul�meter.

  – designed for the case of igni�on system with single coil on single spark.DI (Coil-On-Plug)

 NOTE: StudioBOSA has a  mode sensi�ve build-in Help system which allows in a quick and easy 
way to get the basic informa�on of current working mode func�onality and opera�onal procedures. 
To see the Help box, from the Main menu select , or click on Help bu�on in Help → StudioBOSA Help
the Tools panel or press F1 key. 

 Changes of the gas pressure in the inlet manifold measurement etc.

 Current measurement. Example – primary igni�on current measurements using current 
clamps.

 Voltage measurement of electrical signals. Example - signals from various sensors in the 
vehicle. 

 NOTE: StudioBOSA has a build-in Demo mode of opera�on for quick overview of applica�on 
capabili�es. To ac�vate this mode, from the Main menu select . Se�ngs → Demo Mode

 Cylinder’s pressure and compression measurement.
 Pulsa�ons of the exhaust gases in the exhaust system measurement.

 Secondary igni�on voltage measurement using high-voltage 10000:1 capaci�ve pick-up 
clamps.

 StudioBOSA allows for:

 Voltage measurement in the range of ±200 V or ±400 V by using 10:1 or 20:1 a�enuators 
plugged in the oscilloscope’s inputs. Example – primary igni�on voltage.
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 3.5 Universal modes of opera�on

 3.5.1 Oscilloscope
 
 , . To ac�vate this mode from the Main menu click This mode offers all the Modes → Oscilloscope
basic universal lab scope func�onality.

  StudioBOSA is star�ng always in Oscilloscope mode.NOTE:

Control panel in Oscilloscope
mode.

  – Current ±20 А (1 mV / 10 mA)

  – Current ±600 А (1 mV / A)  
  – Current ±60 А (1 mV / 100 mA)

  – Voltage 1:1 

 Select the input measurement range.

 Invert the signal (so�ware only).

 To ac�vate or deac�vate a given channel, click on 
its le�er in the Control panel. When channel is ac�ve, a 
color field with addi�onal controls opens.

 Select  AC/DC input coupling.

  – Voltage 20:1

 Select the type of measurement:

  – Voltage 10:1

 In the  sec�on you can select the �me range of Time
the current measurement.

 In the color field you can:

  Single (wai�ng) trigger mode is available only in �me ranges from 200 µs to 2 s.NOTE:

 In the  sec�on you can set the trigger event parameters, including:Trigger

  – Auto - the measurement always takes place regardless of whether a trigger event has 
occurred or not. If this event doesn’t occur, the program automa�cally switches to free trigger mode 
and starts the measurement immediately.
  – Free - the measurement takes place without wai�ng for a trigger event. It is suitable for ini�al 
overview of an unknown signal and allows for correct determina�on of the trigger point.
  – Single (wai�ng) - the measurement is performed only once a�er trigger event occurrence. It 
is suitable for non-periodic, one-�me signals such as single pulses or transient processes.

 Select the trigger type:

 Select the trigger channel.
 Select the trigger edge - rising or falling.
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 To set the trigger level and pretrigger value (i.e. what por�on of the signal is visible before the 
trigger event):
 Click on the trigger point and hold the mouse bu�on down to move it to the required posi�on 
on the oscillogram screen. 

  You can open or close the Control panel by clicking on the small arrow bu�on in the NOTE:
upper right corner of the screen or using F9 shortcut key. 

 Select Wait-before-free �me - this is the �me interval, during which the applica�on is s�ll in 
auto trigger mode for a missing trigger event before the measurement switches to free trigger mode.

  Pretrigger is available only in �me ranges from 200 µs to 2 s. NOTE:

 To move the given channel’s waveform up or down on the screen, click on the ver�cal axis of the 
channel, hold the mouse bu�on down and move up or down the graphics.

 Click on the �me axis under Oscillogram screen, hold the mouse bu�on down and move to the 
le� or right to set the pre�riger value.

 Select the holdoff value - this is the �me interval a�er a trigger event occurrence, during which 
a new trigger event is forbidden. It is only a�er this interval that the applica�on again begins to wait for 
a new trigger event and starts next measurement. This se�ng is important in the observa�on of the 
signals with several fundamental frequencies in their spectrum. Typical example are the rectangular 
digital signal packets.

12

Tools panel in Oscilloscope mode.

 In the  you can:Tools panel
 Start or stop the current measurement by clicking on the Start/Stop bu�on.
 Make an observa�on of the last 100 oscillograms of the current measurement.
 Ac�vate 720° phase markers.

 Launch the applica�on help.

  Also, you can save the applica�on’s screen as an image using Main menuNOTE:  File → Save 
Screen... Help → StudioBOSA Helpor Ctrl+G keyboard shortcut. To launch the applica�on help use  or F1 
shortcut.

  Status and dura�on of the current measurement are shown in the Status bar.NOTE:

 Save the applica�on’s screen as an image.
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Graphics panel in Oscilloscope mode. Trigger point and
720° rota�on phase markers shown.

 720° phase markers are specially designed to help in phase determina�on of the processes 
related to the cranksha� rota�on cycles. 

 To use a 720° phase markers:

 Click and drag the le� and right arrows in order to set the 0° and 720° points on the oscillogram.
 Click and drag the marker box to see the phase posi�on of given point on the oscillogram.

 Click on the 720° bu�on in the Tools panel or press F2 to ac�vate markers if they are not visible.
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 3.5.2 Stream

 , . To ac�vate this mode from the Main menu click This mode shows current Modes → Stream
measurements as a con�nuous data stream on the screen. It is suitable for signals with periods from 1 s 
to 1 min.

Control panel in Stream mode.

Tools panel in Stream mode.

 In the  you can:Tools panel
 Start or stop the current measurement by clicking on the Start/Stop bu�on.
 Choose how to see individual measurements, as a single screens or as a con�nuous data 
stream.
 Make an observa�on of the last 100 oscillograms of the current measurement.
 Save the applica�on’s screen as an image.
 Launch the applica�on help.

  Status and dura�on of the current measurement are shown in the Status bar.NOTE:

 Select the input measurement range.

 Invert the signal (so�ware only).

  – Voltage 20:1

 Select the type of measurement:

 In the  sec�on you can select the �me range of Time
the current measurement.

  – Current ±600 А (1 mV / A)  

  – Current ±20 А (1 mV / 10 mA)

 To ac�vate or deac�vate a given channel, click on 
its le�er in the Control panel. When channel is ac�ve, a 
color field with addi�onal controls opens.

 In the color field you can:

  – Voltage 10:1
  – Voltage 1:1 

 Select  AC/DC input coupling.

  – Current ±60 А (1 mV / 100 mA)
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 3.5.3 Slow Variable

 , . To ac�vate this mode from the Main menu click This mode shows Modes → Slow Variable
current measurements as a con�nuous data stream on the screen. It is suitable for slow in �me signals  
with periods from min to hour or more.1 
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Control panel in Slow Variable
mode.

Tools panel in Slow Variable mode.

  – Current ±20 А (1 mV / 10 mA)
  – Voltage 20:1

 Select the input measurement range.

 In the  sec�on you can select the �me range of Time
the current measurement.

  – Current ±600 А (1 mV / A)  

 To ac�vate or deac�vate a given channel, click on 
its le�er in the Control panel. When channel is ac�ve, a 
color field with addi�onal controls opens.

 Invert the signal (so�ware only).

  – Voltage 10:1

 Select  AC/DC input coupling.

  – Current ±60 А (1 mV / 100 mA)

 Select the type of measurement:

 In the color field you can:

  – Voltage 1:1 

 In the  you can:Tools panel

  Status and dura�on of the current measurement are shown in the Status bar.NOTE:

 Save the applica�on’s screen as an image.
 Launch the applica�on help.

 Start or stop the current measurement by clicking on the Start/Stop bu�on.
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 , . To ac�vate this mode from the Main menu click This mode shows Modes → Mul�meter
current measurements as a discrete values in digital form. It allows BOSA oscilloscopes to be used as a  
mul�channel digital mul�meter.

 3.5.4 Mul�meter

16

Control panel in Mul�meter
mode.

Tools panel in Mul�meter mode.

  – Voltage 1:1 

  – Current ±60 А (1 mV / 100 mA)

 In the color field you can:
 Select the input measurement range.

 To ac�vate or deac�vate a given channel, click on 
its le�er in the Control panel. When channel is ac�ve, a 
color field with addi�onal controls opens.

 Select the type of measurement:

  – Voltage 10:1
  – Voltage 20:1
  – Current ±20 А (1 mV / 10 mA)

  – Current ±600 А (1 mV / A)

 In the  sec�on you can select the �me range of Time
the current measurement. Note that the refresh rate for 
digital values and data stream changes accordingly.

 Launch the applica�on help.

 Start or stop the current measurement by clicking on the Start/Stop bu�on.

  Status and dura�on of the current measurement are shown in the Status bar.NOTE:

 In the  you can:Tools panel

 Save the applica�on’s screen as an image.
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 By le� clicking and dragging up and down the small marker on the top right corner of the 
channel’s oscillogram sec�on you can resize the graphics for more comfortable view of the data 
stream.

Graphics panel in Mul�meter mode.
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 NOTE: This mode is not suitable for observa�on of pure lab signal as sinusoid, rectangular, 
triangular and so. For measurements on such kind of waveforms, please use the Oscilloscope mode 
(see sec�on 3.5.1).

 Connect high-voltage capaci�ve pick-up clamp to the common cable between the igni�on coil 
and  distributor (as close as possible to the coil) and plug it to channel A on the oscilloscope. Connect 
ground wire to the vehicle’s chassis ground. Start the engine and let it idle.

 Igni�on system with mechanical distributor: 

 DIS – Wasted Spark or DI – Coil-On-Plug igni�on:

  For secondary igni�on system observa�on this mode should be used with high-voltage NOTE:
10000:1 capaci�ve pick-up clamps.

 3.6 Igni�on diagnos�c modes

 , . This is an universal To ac�vate this mode from the Main menu click Automo�ve → Sparkscope
oscilloscope for quick and easy overview of the periodic signals and specially of those, containing 
narrow spikes (needles) in their spectrum, such as igni�on diagrams (primary or secondary) in petrol 
engines, injector signal (voltage or current) and so.

  Secondary high-voltage igni�on circuit You must use only high-voltage capaci�ve CAUTION: ! 
pick-up clamps Using standard oscilloscope leads and probes will cause a serious damage of the ! 
instrument! 

 3.6.1 Sparkscope

 Connect high-voltage capaci�ve pick-up clamps to the secondary igni�on cables (as close as 
possible to the spark plugs) and plug them to the oscilloscope’s input channels. Connect ground wires 
to the common point on the vehicle’s chassis ground. Start the engine and let it idle.

An example connec�on of BOSA-02 for observa�on of the igni�on in Sparkscope 
mode for a DI – Coil-On-Plug system (the diagram demonstrates the use of an 
extension cable between spark plug and the coil). 

1. Capaci�ve pick-up clamp
2. DI coil pack
3. Spark plug
4. BOSA-02

1

3

2

4

BOSA User Manual Rev. 2.4 – 07 May 2024

www.benev.bizBOSA-02; BOSA-04

https://benev.biz
https://benev.biz


19

Control panel in Sparkscope
mode.

 Select the input measurement range.

 To ac�vate or deac�vate a given channel, click on 
its le�er in the Control panel. When channel is ac�ve, a 
color field with addi�onal controls opens.

 In the color field you can:

 Select the type of measurement:
  – Voltage 1:1 

  – Voltage 20:1
  – Current ±20 А (1 mV / 10 mA)
  – Current ±60 А (1 mV / 100 mA)

  – Voltage 10000:1 (capaci�ve)  
 Select  AC/DC input coupling.
 Invert the signal (so�ware only).

 In the  sec�on you can select the �me range of Time
the current measurement.

  – Voltage 10:1

  – Current ±600 А (1 mV / A) 

 Select the trigger type:
 In the  sec�on you can set the trigger event parameters, including:Trigger

  You can open or close the Control panel by clicking on the small arrow bu�on in the NOTE:
upper right corner of the screen.

 Select the holdoff value (see explana�on in 3.5.1). 

 Select the trigger channel.

 Select Wait-before-free �me (see explana�on in 3.5.1).

  – Free - the measurement takes place without wai�ng for a trigger event. It is suitable for ini�al 
overview of an unknown signal and allows for correct determina�on of the trigger point.

 Select the trigger edge - rising or falling, independently on each channel.

  – Single (wai�ng) - the measurement is performed only once a�er trigger event occurrence. It 
is suitable for non-periodic, one-�me signals such as single pulses or transient processes.

  – Auto - the measurement always takes place regardless of whether a trigger event has 
occurred or not. If this event doesn’t occur, the program automa�cally switches to free trigger mode 
and starts the measurement immediately.
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 In the  you can set the main trigger level and pretrigger value on the current Oscillogram screen
trigger channel (main trigger point) and independently, trigger levels for the other channels. 
Controlling trigger edge and level in such a way on each channel is helpful in long �me ranges of 
observa�on (hundreds of milliseconds) of signals with high frequency spikes in their spectrum, for 
example, firing lines in igni�on waveforms.

Main trigger point

Trigger markers

 To move the given channel’s waveform up or down on the screen, click on the ver�cal axis of the 
channel, hold the mouse bu�on down and move up or down the graphics.

  Double click on main trigger marker to stack together all trigger markers and move them NOTE:
using only main trigger marker. In this case the trigger level is determined by the main trigger marker 
posi�on.

 NOTE: The colors and le�ers of the trigger markers change accordingly to the choice of trigger 
channel.

 Click on main trigger marker and drag it to set the trigger level and pretrigger value on current 
trigger channel. Alterna�vely, click on the �me axis under Oscillogram screen, hold the mouse bu�on 
down and move to the le� or right to set the pretrigger value.

 Click on one of the other trigger markers in the right side of the screen and move it up or down 
to set the trigger level for the given channel independently. Please, no�ce when marker is moved in 
such a way it  become unstacked and its color fill mode is changing from solid to frame.

Main trigger point and trigger markers for each channel.
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Tools panel in Sparkscope mode.

 Save the applica�on’s screen as an image.
 Launch the applica�on help.

 In the  you can:Tools panel
 Start or stop the current measurement by clicking on the Start/Stop bu�on.

 Ac�vate 720° phase markers.
 Make an observa�on of the last 100 oscillograms of the current measurement.

  See in sec�on 3.5.1 for more informa�on about how to use 720° phase markers. NOTE:

 NOTE: Status and dura�on of the current measurement are shown in the Status bar.
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  Secondary high-voltage igni�on circuit You must use only high-voltage capaci�ve CAUTION: ! 
pick-up clamps Using standard oscilloscope leads and probes will cause a serious damage of the ! 
instrument!

 , . To ac�vate this mode from the Main menu click This mode Automo�ve → Distributor
measures igni�on in the secondary circuit of systems with mechanical distributor.

 3.6.2 Classic igni�on with mechanical distributor

 Connect high-voltage capaci�ve pick-up clamp to the common wire between the igni�on coil 
and  distributor (as close as possible to the coil) and plug it into channel A on the oscilloscope. Connect 
ground wire to the vehicle’s chassis ground. In order to have a correct RPM value and first cylinder 
synchroniza�on, connect the induc�ve pick-up clamp to the high-voltage cable on the first cylinder 
(near the spark plug) and plug it into channel B on the oscilloscope. Start the engine and let it idle.

  You can use a standard high-voltage 10000:1 capaci�ve pick-up clamp to measure RPM NOTE:
instead of induc�ve one.

1-3-4-2. When used with an engine with a different firing order or a different number of cylinders, the 
igni�on pa�ern for a given cylinder and its number on the screen will not match with each other. In the 
case of different number of cylinders in the engine, the displayed RPM value will also be incorrect.

  This mode is designed to measure a 4-cylinder engine with a standard firing order of NOTE:

  This mode should be used with high-voltage 10000:1 capaci�ve pick-up clamps.NOTE:

1

3
2

4

5

1. Capaci�ve pick-up clamp
2. Igni�on coil
3. Distributor
4. Induc�ve pick-up clamp
5. Spark plugs
6. BOSA-02

6
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Tools panel in Distributor mode.

 In the  you can:Tools panel

 Choose the cylinders display pa�ern: 
 Start or stop the current measurement by clicking on the Start/Stop bu�on.

 – Parade. The individual cylinders are displayed side by side.
 – Raster. The individual cylinders are displayed one above the other.

 Make an observa�on of the last 100 oscillograms of the current measurement.

 Launch the applica�on help.

 – Overlay. The individual cylinders are superimposed on one another.

 NOTE: If a correct first cylinder synchroniza�on is present, the number "1" is shown in the 
upper le� corner of the screen. Otherwise, the "?" symbol is displayed.

 NOTE: Status and dura�on of the current measurement are shown in the Status bar.

 Save the applica�on’s screen as an image.

  If a correct first cylinder synchroniza�on is present, the RMP value is shown in the right NOTE:
side of Tools panel.

 See engine’s RPM value.

 – Single. Only one cylinder is shown at a �me.

Control panel in Distributor mode.

 In the  sec�on you can set the trigger edge – Trigger
rising or falling.

 In the  sec�on you can set input voltage Range
range simultaneously for all channels.

 In the color field in Control panel you can invert the 
signal (so�ware only).

 In the  sec�on you can select the �me range of Time
the current measurement.

  In this mode trigger is always automa�c and NOTE:
is on channel A only.
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  This mode should be used with high-voltage 10000:1 capaci�ve pick-up clamps.NOTE:

  In this mode, the signal from the cylinder connected to channel A is used to determine NOTE:
the RPM value.

  Connect two high-voltage capaci�ve pick-up clamps to the spark plug wires pair from BOSA-02:
a single igni�on coil and plug them into oscilloscope inputs. Connect ground wires to the common 
point on the vehicle’s chassis ground. Start the engine and let it idle.

1-3-4-2 with a common igni�on coil on cylinders 1-4 and 2-3 respec�vely. When used with an engine 
with a different firing order or a different number of cylinders, the igni�on pa�ern for a given cylinder 
and its number on the screen will not match with each other. In the case of different number of 
cylinders in the engine, the displayed RPM value will also be incorrect.

  This mode is designed to measure a 4-cylinder engine with a standard firing order of NOTE:

  Connect four high-voltage capaci�ve pick-up clamps to the four spark plug wires BOSA-04:
from two igni�on coils and plug them into oscilloscope inputs, respec�vely, the 1st cylinder - channel 
A, 2nd cylinder - channel B, 3rd cylinder - channel C, 4th cylinder - channel D. Connect ground wires to 
the common point on the vehicle’s chassis ground. Start the engine and let it idle.

 
 , . To ac�vate this mode from the Main menu click This mode Automo�ve → DIS – Wasted Spark
measures igni�on in the secondary circuit of systems with single coil on two plugs.

 3.6.3 DIS – Wasted Spark igni�on

  Secondary high-voltage igni�on circuit You must use only high-voltage capaci�ve CAUTION: ! 
pick-up clamps Using standard oscilloscope leads and probes will cause a serious damage of the ! 
instrument!

1. Capaci�ve pick-up clamps
2. DIS coil pack
3. Spark plugs
4. BOSA-04

1

3

2 4
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Control panel in DIS – Wasted Spark 
mode

Tools panel in DIS – Wasted Spark mode.

  In this mode trigger is always automa�c and NOTE:
suggests a common igni�on coil on cylinders 1-4 and 2-3 
respec�vely.

 In the color field in Control panel you can invert the 
signal (so�ware only).

 In the  sec�on you can set input voltage Range
range simultaneously for all channels.

 In the  sec�on you can select the �me range of Time
the current measurement.

 In the  sec�on you can set the trigger edge – Trigger
rising or falling.

 – Single. Only one cylinder is shown at a �me.
 Make an observa�on of the last 100 oscillograms of the current measurement.
 Save the applica�on’s screen as an image.

  Status and dura�on of the current measurement are shown in the Status bar.NOTE:

 Launch the applica�on help.

 – Parade. The individual cylinders are displayed side by side.
 Choose the cylinders display pa�ern: 

 See engine’s RPM value.

 – Raster. The individual cylinders are displayed one above the other.
 – Overlay. The individual cylinders are superimposed on one another.

 In the  you can:Tools panel
 Start or stop the current measurement by clicking on the Start/Stop bu�on.
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 NOTE: Very o�en in the modern vehicles the igni�on coils are mounted directly on top of the 
spark plugs, either individually or in a common monolithic block. It is necessary to use a set of high-
voltage extension cables for igni�on diagnos�cs.

  In this mode, the signal from the cylinder connected to channel A is used to determine NOTE:
the RPM value.

 

  This mode should be used with high-voltage 10000:1 capaci�ve pick-up clamps.NOTE:

  This mode is designed to measure a 4-cylinder engine with a standard firing order of NOTE:

 3.6.4 DI – Coil-On-Plug igni�on

  Connect two high-voltage capaci�ve pick-up clamps to the spark plug wires for any BOSA-02:
two cylinders and plug them into oscilloscope inputs. Connect ground wires to the common point on 
the vehicle’s chassis ground. Start the engine and let it idle.

  Secondary high-voltage igni�on circuit You must use only high-voltage capaci�ve CAUTION: ! 
pick-up clamps Using standard oscilloscope leads and probes will cause a serious damage of the ! 
instrument!

 , . To ac�vate this mode from the Main menu click This mode Automo�ve → DI – Spark-On-Plug
measures igni�on in the secondary circuit of systems with single coil on single plug.

  Connect four high-voltage capaci�ve pick-up clamps to the four spark plug wires and BOSA-04:
plug them into oscilloscope inputs, respec�vely, the 1st cylinder - channel A, 2nd cylinder - channel B, 
3rd cylinder - channel C, 4th cylinder - channel D. Connect ground wires to the common point on the 
vehicle’s chassis ground. Start the engine and let it idle.

1-3-4-2. When used with an engine with a different firing order or a different number of cylinders, the 
igni�on pa�ern for a given cylinder and its number on the screen will not match with each other. In the 
case of different number of cylinders in the engine, the displayed RPM value will also be incorrect.

1. Capaci�ve pick-up clamps
2. DI coil packs
3. Spark plugs
4. BOSA-04

1

3

2
4
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Control panel in DI – Coil-On-Plug 
mode

Tools panel in DI – Coil-On-Plug mode.

 In the  sec�on you can select the �me range of Time
the current measurement.

 In the  sec�on you can set the trigger edge – Trigger
rising or falling.

  In this mode trigger is always automa�c and NOTE:
suggests a 1-3-4-2 firing order.

 In the  sec�on you can set input voltage Range
range simultaneously for all channels.

 In the color field in Control panel you can invert the 
signal (so�ware only).

 Start or stop the current measurement by clicking on the Start/Stop bu�on.
 Choose the cylinders display pa�ern: 

 In the  you can:Tools panel

 – Raster. The individual cylinders are displayed one above the other.

 Save the applica�on’s screen as an image.

 – Parade. The individual cylinders are displayed side by side.

 Make an observa�on of the last 100 oscillograms of the current measurement.
 – Single. Only one cylinder is shown at a �me.

 Launch the applica�on help.

 – Overlay. The individual cylinders are superimposed on one another.

 See engine’s RPM value.

  Status and dura�on of the current measurement are shown in the Status bar.NOTE:
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 To change the current applica�on language:

 StudioBOSA is an applica�on designed to support a wide range of automo�ve professionals in 
their everyday work experience and one of its important benefits is built-in mul�lingual support for 
graphical interface and documenta�on.

  When the applica�on is star�ng for the first �me on your computer, the default language NOTE:
is English. 

 In the popup dialog box, confirm your selec�on and StudioBOSA will automa�cally close and 
restart with the new language se�ngs.

 3.7 Mul�lingual support

 From the Main menu click on  select the language you prefer.Se�ngs → Language

  The applica�on help file launches in the language version corresponding to the current NOTE:
applica�on language.
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 StudioBOSA allows for customiza�on through se�ng user’s preferences . 

 To launch the Preferences box, from the Main menu click on Se�ngs → Preferences...

 3.8 Applica�on preferences

 In the Graphics page you can choose the color for every channel and set the drawing line width. 
Click on the Reset bu�on if you want to set back colors to their default values.
 In the Mul�meter page you can choose the color scheme (color or monochrome) and font style 
(7-segment or dot-matrix) for digital mul�meter display. 

 When you are ready click OK bu�on. The preferences will take place immediately. On the next 
launch StudioBOSA will start with the new se�ngs.

Preferences dialog box.
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  Appendix А: Shortcut keys in StudioBOSA

Specifica�ons

Space

A

B

C

D

 Start/Stop measurement

 Ac�vate/deac�vate channel A 

Ac�vate/deac�vate channel B 

Ac�vate/deac�vate channel C 

Ac�vate/deac�vate channel D 

Keys

Ctrl+A Moves the keyboard input focus to channel A

Ctrl+B

Ctrl+C

Ctrl+D

Up arrow

Down arrow

 Moves the keyboard input focus to channel B

Moves the keyboard input focus to channel C

Moves the keyboard input focus to channel D

Increases the input voltage range

Decreases the input voltage range

Right arrow Increases the �me range

Ac�on

Le� arrow

Shi�+Up arrow

Shi�+Down arrow

Shi�+Right arrow

Shi�+Le� arrow

Decreases the �me range

 Moves the trigger point up 

Moves the trigger point down 

Moves the trigger point right 

Moves the trigger point le�

Page Up Shows the next screen

Page Down

Home

End

H

1

 Shows the previous screen

Shows the first screen

Shows the last screen

Scrolls down the igni�on screen modes

Shows igni�on of the first cylinder only

2 Shows igni�on of the second cylinder only

3 Shows igni�on of the third cylinder only

4 Shows igni�on of the fourth cylinder only

BOSA User Manual Rev. 2.4 – 07 May 2024

www.benev.bizBOSA-02; BOSA-04

https://benev.biz
https://benev.biz


31

Specifica�onsKeys Ac�on

F1

Ctrl+G

Esc

 Applica�on help

 Saves applica�on screen as an image

Applica�on exit 

F2  Shows / hides 720° phase markers

F9  Shows / hides Control panel
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  Index

Distributorless Igni�on System (DIS) 

Firing order

Current clamp

Drivers

Equivalent-�me sampling (ETS)

A�enuator

Extension cable

Free trigger

Auto trigger

Capaci�ve pick-up clamp
Coil pack 

Direct Igni�on (DI)
Distributor

Galvanic isola�on
Ground wires

Holdoff

Induc�ve pick-up clamp

Oscilloscope

Overlay
Oscilloscope probe

Igni�on coil
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18, 24, 26

22
10, 24
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6, 7
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5
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22, 24, 26

18, 22, 24, 26

18, 22, 24, 26

22

Rounds per minute (RPM)

Wai�ng trigger

Universal oscilloscope  

Single trigger

Pretrigger

Trigger point

Primary igni�on

Raster

Parade

Secondary igni�on

Trigger

Phase markers

Real-�me sampling (RTS)

Sampling rate

Spark plug
Stream

Trigger event
Trigger edge

Wait-before-free 

12

10, 18

23, 25, 27
4

4

18, 22, 24, 26
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23, 25, 27

18, 22, 24, 26
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